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Arts  

Quarter 4 – Module 3:  

Manifests Understanding of 

Concepts on the Use of Software 

 

 



 

 

Introductory Message 

This Self-Learning Module (SLM) is prepared so that you, our dear learners, 

can continue your studies and learn while at home.  Activities, questions, directions, 

exercises, and discussions are carefully stated for you to understand each lesson.  

Each SLM is composed of different parts.  Each part shall guide you step-by-

step as you discover and understand the lesson prepared for you.  

Pre-tests are provided to measure your prior knowledge on lessons in each 

SLM. This will tell you if you need to proceed on completing this module or if you 

need to ask your facilitator or your teacher’s assistance for better understanding of  

the lesson. At the end of each module, you need to answer the post-test to self-check 

your learning. Answer keys are provided for each activity and test. We trust that you 

will be honest in using these.  

In addition to the material in the main text, Notes to the Teacher are also 

provided to our facilitators and parents for strategies and reminders on how they can 

best help you on your home-based learning.  

Please use this module with care. Do not put unnecessary marks on any part 

of this SLM. Use a separate sheet of paper in answering the exercises and tests.  And 

read the instructions carefully before performing each task.  

If you have any questions in using this SLM or any difficulty in answering the 

tasks in this module, do not hesitate to consult your teacher or facilitator.  

Thank you. 
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What I Need to Know 

MANIFESTS UNDERSTANDING OF CONCEPTS ON THE 

USE OF SOFTWARE(A6PR-Ivb) 

 Modern technology offers several opportunities in various fields including how 

we produce art. Through the advancement of technology, several designers and 

artists have developed their skills in using graphic design software to express their 

ideas. 

This module was designed and written with you in mind. It is here to help you 

manifest an understanding of concepts on the use of graphic design software 

specifically on in creating digital arts since this is the type of artwork produced using 

graphic design software. Moreover, it is a legitimate art form separate from  like 

painting, sculpture, architecture, and the likes. At the end of this module, you are 

expected to: 

1. Define what are menu, commands, and tools; 

2. Manifest understanding of concepts on the use of software (commands, menu, 

and tool); 

3. Know that command, menu, and tools are used in creating artwork. 
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What I Know 

 
Before you start studying this module, answer this simple test to find out what 

you already know about the topic. Choose the letter of the best answer and write the 
chosen letter on a separate sheet of paper. 

 

1. What do you call a set of instructions data or programs used to operate 
computers and execute a specific task?  
A. computer      B. blender         C. software            D. menu 

 

2. It can easily follow the desired curvature of lines through the use of anchor 
points. What is it? 

A. paths tool     B. pen tool         C. brush tool         D.  dodge tool  
 

3. Which of the following tools used to create a point or line in any direction? 
A. Brush Tool                                 C.  Bucket fill Tool            
B. Dodge Tool                                 D.  Pen Tool 

 

4. In our lesson, what are the three examples that a user may use in creating 
digital artwork? 

A. Menu, command, and tool          C. Tool, menu, and software 
B. Command, software and             D. software, malware, and  

hardware                                         hardware 
 

5. What do you call to the list of commands or choices offered to the user 
through the menu bar to find information or execute a program function? 

A. tools            B. command           C. software            D. menu 
 

6. Which of the following instructs a computer or device to perform a specific 
task? 
A. malware      B. command           C. tools                  D. menu 

 

7. The three options that can be used in creating digital artwork are tools, 

command, and________? 
A. menu          B. software             C. hardware           D. computer 

 

8. Why is  photoshop used for photo editing and raster graphic design 
software? 
A. It allows the users to create, edit, and manipulate various graphics. 
B. It can’t import the images in various file formats. 

C. It allows the users to create and edit rater images. 
D. both A and C 

 

9. This tool is used to color a larger portion of your artwork. What is this? 
_______. 
A. dodge tool     B. bucket fill tool         C.  pen tools            D. brush tool 

 
10.  What do you call the art created from graphic design software? 

A. Digital Camera       B. GIMP              C. Photoshop          D. Digital Art 
 

Well, how was it? Do you think you did it well? Compare your answer with 
those with the answer key.  
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Lesson 

1 
Manifests Understanding of Concepts 
on the use of Software 

(Commands, Menu and Tools) 

 

 Some artists use materials like paints and brushes to create art. Today, many 

others also use modern technology of exploring creativity, like video technology, 

television, and computers. This type of art is called digital art.  

 Art created from graphic design software is called digital art. Its work is made 

with digital technology or presented on digital technology. This includes images done 

completely on a computer or hand-drawn images scanned into a computer and 

finished using a software program. 

To create digital artwork effectively, it is a must to understand concepts on 

the use of software on command, menu, and tools. 

According to Merriam Webster, software is something used or associated 

with and usually contrasted with hardware such as programs for a computer. It 

comprises the entire set of programs, procedures, and routines associated with the 

operation of a computer system. 

Graphic design software is an example of software for creating digital art. Its 

importance is to design any graphics-related things. There are many more things you 

can do with the graphic design software like editing your family photo and designing 

greeting cards for the upcoming birthday celebration. 

In this lesson, the pupils will learn about the concepts of the use of software 

(commands, menu, and tools) in creating artwork that will develop their 

understanding of the use of this technology. 

  

https://www.merriam-webster.com/dictionary/hardware
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What’s In 

Directions: Match the picture in Column A to its name in Column B. 

 

                       Column A           Column B 

1.  

 

 

A. Bucket fill 

2.  

 

 

B. Menu 

3.  

 

 

C. Pen Tool 

4.  

 

 

D. Tool 

5.  

 

E. Command 

 

  

https://www.google.com.ph/url?sa=i&url=https://www.flickr.com/photos/gumara/2948744708&psig=AOvVaw0XYLdF3VBc4Tgu0HjGJEdi&ust=1596954806293000&source=images&cd=vfe&ved=0CAIQjRxqFwoTCNCMqbP-iusCFQAAAAAdAAAAABAD
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What’s New 

A drawing made with a graphic design software uses the same art elements as 

traditional media like pen, pencil, and paint. The picture shows the example of a 

digital drawing. This can be drawn using the GIMP or GNU Image Manipulation 

Program and can be enhanced using the Photoshop CC applications. 

 
 

1. What are the different lines and shapes that you can see in the drawing? 
2. What do these lines and shapes represent in the drawing? 

 

This lesson will give you basic knowledge in digital art specifically on GIMP 

and Photoshop CC applications. 

 

 

What is It 

 

Definition of Software 

Everything that runs on a computer from an operating system to a diagnostic 

tool, video game, or app can be defined as software. 

Software is a set of instructions data or programs used to operate computers 

and execute a specific task. It is also a collection of data or computer instructions 

that tell the computer how to work. 

When you use your computer software there are menus, tools, and commands 

that you must know. 

What do menus, tools, and commands tell us? 

A menu is a list of commands or choices offered to the user through the menu 

bar. It is also a set of options presented to the user of a computer application to help 

the user find information or execute a program function. 
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The menu is an application organizer and launcher. There are other 

commands in a menu. 

Here is an example of a menu when you use your computer. 

 

 

 

 

 

 

 

 

A command is an instruction to a computer or device to perform a specific 

task. This can be a text or an icon. 

 

 

 

 

 

Tools are used to make the artwork more meaningful, colorful, and attractive. 

It can be a pen tool, brush tool, bucket fill tool, and dodge tool. 

 

 

 

 

 

 

These are some of the examples of tools used to paint. 

 

 

 

 

 

 

command 

tools 

 

a. Pen Tool is easily recognizable because 

of its resemblance to a pen. It is used to 

create a point or a line in any direction. 

 

https://www.google.com.ph/url?sa=i&url=https://www.flickr.com/photos/gumara/2948744708&psig=AOvVaw0XYLdF3VBc4Tgu0HjGJEdi&ust=1596954806293000&source=images&cd=vfe&ved=0CAIQjRxqFwoTCNCMqbP-iusCFQAAAAAdAAAAABAD
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The menus, tools, and commands are usually displayed on the screen once 
you open a program. These are used when you apply digital art. 

We have a lot of applications for digital art. Adobe Photoshop is one of these 
applications.  

Photoshop CC is a photo editing and raster graphic design software that allows 
users to create, edit, and manipulate various graphics as well as digital art. It also 
allows to create and edit raster images with multiple layers and import the images in 

various file formats. Photoshop is developed by Adobe Systems for both Windows and 
macOS. 

In addition, Photoshop CC is not an open-source application. The version that 

you will be downloading is a trial version. However, you can continue using it after 
your trial period by purchasing the software. 

  

 

b. Brush Tool is represented by drawing of 

a paintbrush. It very similar to the pen 

tool. 

 

c. Bucketfill tool is used to color a larger 

portion of your artwork. It is represented 

by a tilted paint bucket. 

 

 

d. Dodge Tool is use when adding details 

such as light reflecting on an object. It 

is useful in applying this type of effect 

in you work. 

 

 

e. Paths tool can easily follow the desired 

curvature of lines through the use of 

anchor points. 
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Before you can use this application, you need to download and install this first 

on your computer. Here are the steps on how to download and install Photoshop CC 

for a free trial. 

Step 1. Go to the browser or google search tab, and type Photoshop CC free 

download. 

 

 

 

 

 

 

  

 

 

Step 2. Click Photoshop CC free download. 

 

 

 

 

 

 

 

 

 

 

Step 3. Click Download. 

 

 

 

 

 

 

 

 

 

 

 

Type 

Select 



 

9 
CO_Q4_Arts 6_ Module 3 

Step 4. Click again the “Download”. 

 

 

 

 

 

 

 

 

 

Step 5. Click “Next” to download. 

 

 

 

 

 

 

 

 

 

Step 6. The  Adobe Photoshop CC is now downloading. 
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Step 7. The Adobe Photoshop CC will ask “Select Setup Language”. Click 

“English” then “OK”. 

 

 

Step 8. The system will run for the next step. 
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Step 9. Click “next”. 

            

 

Step 10. Click “Accept” to continue. 
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Step 11. Now, click “Run” to execute the downloaded file. 

 

 

Step 12. Wait until the downloaded file is ready to open. 
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Step 13. Now click the downloaded “adobe photoshop” below then click “Open 

file”. 

 

 

Step 14. This will appear once you click the downloaded file. Click “Try”. 

 

 

 

 

 

 

Click 
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Step 15. Click “Sign in” to install the application on your desktop or laptop.  

 

 

Step 16. Adobe Software License Agreement will appear. Click “Accept” after 

you have read it. 
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Step 17. Wait for the installation process to finish. 

 

 

Step 18. The installation is now complete. Click “Launch Now”. 
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Step 19. The Adobe Photohop required you to sign in but click “Sign in Later”. 

 

 

Step 20. Now you can start the Photoshop CC 2014 Trial version for free by 

clicking “Start Trial”. 

 

 Remember, Photoshop CC is not open-source. This is a trial version. You can 

continue to use Adobe Photoshop CC 2014 after your trial period by purchasing the 

software. For this reason, you need money to pay for it. However, as a beginner like 

you, it is already a big help that you have learned how to download and use this 

application even in a trial version. This will benefit you when you want to become a 

graphic artist in the future.  
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What’s More 

 

Another application for digital art is GIMP or GNU Image Manipulation 

Program. It is a user-friendly app for digital art design. 

 GIMP is an excellent open-source photo editing program. It has a list of tools 

for the user to edit their photos. It has plenty of brushes, filters, auto image-

enhancement tools, and compatibility for a wide range of pre-installed plugins as 

well as more available for download. It also allows you to add filters. 

 Here are the steps on how to use GIMP. 

Step 1. Installing GIMP 

 Download the GNU image manipulation program. Open the downloaded file 

and select your preferred language. Run the installer, if you want to install it in the 

default folder then click on install. To change any install setting select customize and 

wait until the installation process gets finished. 

Step 2. Preparation  

 Launch GIMP. If you have a sketch or photo to use as a template for your 

drawing, select “Open” from the “File” menu, and locate that image file. If you are 

drawing without an image, select “New” from the “File” menu to create a new image 

file.  

 Click the “Background” layer in the layers panel and type “50” in the “opacity” 

text field if you have opened a sketch or photo for your drawing. This will make the 

sketch or photo semi-transparent, allowing you to more easily see your work when 

you begin drawing. Click the “Lock” check box so you do not accidentally draw on 

this layer. Next Press “Shift-Ctrl-N” on the keyboard to open the New Layer dialog 

box. Type “Drawing” in the “Layer Name” field, select “Transparency” and click “Ok”. 

 Zoom into the image as needed by clicking the “Zoom” menu at the bottom of 

the image window. 

Step 3. Using the Paintbrush Tool 

 Select the “Paintbrush Tool” from the toolbox. Select the “Circle 03” brush 

from the Brushes panel to create a thin line. The number beside the brush indicates 

the diameter in pixels. This brush has a diameter of three pixels. 

 Drag the brush on the canvas in a short stroke. Examine its width in 

comparison to the background image and select a larger or smaller circle brush as 

needed. Then draw lines of your artwork using short even strokes with the mouse. 

Try not to trace the original work, but rather use the background image as a guide 

for your new drawing. Press “Ctrl-Z” to undo a brush as needed. You can press “Ctrl-

Z” repeatedly to delete additional strokes. 
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Step 4. Using the Paths Tool.  

 Select the “Paths Tool” from the toolbox. Click the tool where you want the 

first point of a new line to appear. This creates an anchor point. Click on a second 

point of the line and second anchor points appears, with a line connecting both 

points. Continue drawing the line by creating additional anchor points. 

 Drag an anchor point to move its location. The connecting lines will adjust 

themselves accordingly. Click the line between anchor points and drag it to bend the 

line. Press “Enter” to close the path. The first and last points will be connected. Don’t 

press “Enter” if you do not want to close the path. 

 Click the “Edit” menu and select “Stroke Path” to create a line from the path 

you have drawn. The “Choose Stroke Style” panel opens. Next, Select  “Stroke Line” 

and type the width of the line in the text field. Alternatively, you can select “Stroke 

With A Paint Tool” and select “Paintbrush”. Click the “Stroke” button and the stroke 

will be applied to the line on the path. Then, click “New Layer” in the “Layer” menu, 

and then begin drawing another path. When you apply stoke to the path on any layer, 

all the paths on that layer will be transformed to the new stroke. 

Step 5. Drawing Shapes  

 Add a new layer to your drawing from the “Layer” menu. Click the “Rectangle 

Select Tool” or the “Ellipse Select Tool” to draw with shapes. Drag the tool over the 

canvas to create the shape. 

 Click the “Edit” menu, and then “Stroke Selection.”  Enter a value in the 

“Stroke Line” Field. This value is in pixels, so you can use a value similar to what 

you used for your brush tool-3 pixels in the example. Alternatively, you can select 

the “Stroke with a Paint Tool” option to apply your current paintbrush values to the 

shape. Click “Stroke”. Next, click the “Rotate Tool” and then select the shape to 

change its orientation. The Rotate panel opens. Move the “Angle” slider to rotate the 

shape, and click “Rotate”. This creates a copy of the shape on a new “Transformation” 

layer.  

 Lastly, click the “New Layer” that you drew in the original shape in the Layers 

Panel, and delete it by clicking “Delete Layer” in the “Layer” panel. 

.  
 Now that you have learned how to use the GIMP. Let us try the activity below. 
 

 

 

 

 

 

  

 

Would you like to try it? 
Ready to get drawing? 

Awesome, let’s go! 
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Digital Still-Life Painting 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

RUBRIC 

 

Criteria 

Needs 

Practice 
1-2 

Fair Good 
Very 
Good 

The work is clean and neat     

Lines and shapes are accurate to 
its object’s outline. 

    

Colors are rendered carefully 
using the paths line tool. 

    

Texture details and the use of 

light and shadow are present in 
the output. 

    

The work was submitted on time 

through E-mail or Messenger. 

    

     
                                

This activity is not aligned with the discussion part 
 
 
 
 
 

What you will need: 

 Design software: GIMP (Open Source) 

 A still-life composition set-up (fruits of varying shapes, a 

shallow dish and a vase) 

 Table for the set-up 

 Portable lamp 

What To Do: 

Set-up the selected objects on top of the table. Place the fruits in 

the dish. Smaller fruits must be placed in front. Position the vase 

behind the fruits off center to the right or left side. The position of 

the lamp must be at the side of the set-up. Make sure that the light 

of the lamp is directed at the set-up. 

Using your GIMP, open a canvas in portrait orientation with a size 

of 8.5” x 11”. Using your paths or pen tool, start drawing the 

outline of each object. 

1. After finishing with the outlines, add color to your digital drawing 

using the paintbrush or bucket fill tool. Provide additional details 
to the texture of objects using the pen tool. Use the dodge and burn 

tools to capture light and shadow. 
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What I Have Learned 

 

Software is a set of instructions data or programs used to operate computers 

and execute specific tasks and a collection of data or computer instructions that tell 

the computer how to work. 

In creating artwork, menus, commands, and tools may be used to make it 

beautiful and colorful. 

A menu is a list of commands or choices offered to the user through the menu 

bar and an application organizer and launcher. 

Commands an instruction to a computer or device to perform a specific task. 

This can be a text or an icon. 

Tools are used to make the artwork more meaningful, colorful, and attractive. 

It can be a pen tool, brush tool, bucket fill tool, and dodge tool. 

Graphic Design software is an example of software wherein digital art is 

formed. Its importance is to design any graphics-related things. 

  Digital art is created from graphic design software and its work is made with 

digital technology or presented on digital technology. This includes images done 

completely on a computer or hand-drawn images scanned into the computer and 

finished using a software program. 

 Photoshop is an example application of digital art which edits photo and 

raster graphic design. It allows users to create, edit, and manipulate various graphics 

as well as digital art. 

 GIMP  is also an excellent open-source photo editing program and one of the 

applications in digital art. It is a user-friendly app for digital art design. It has plenty 

of brushes, filters, auto image-enhancement tools, and compatibility for a wide range 

of pre-installed plugins. 
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What I Can Do 

 

  As a beginner like you, let’s navigate more on digital art using the Photoshop 

CC applications. Just follow the following steps. 

How to Use Photoshop CC 

After downloading the Photoshop CC on your personal computers, here are 

the steps on how to use it. 

Step 1. Open up Photoshop Creative Cloud.  

 

 

 

 

 

 

 

 

 

Step 2. Edit your canvas. First, go to File and click New. Always save your work. 

                                    File 
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Step 3. Preview Canvas. A blank page of what it should look like will be shown. Save 

your work again. 

 

 

 

 

 

 

 

 

 

Step 4. Tools. Identify the toolbox on the left-hand side of the screen and get familiar 

with each tool because the tools are important especially the click tool.  

 

 

 

 

 

 

 

 

Step 5: Colors, Folders, and Grouping on the right hand of the screen there is a 

setting to store files and artwork. There are color rangers for shapes and figures. 

Also, there is a Layer setting that will adjust and keep it step separate within the 

artwork. Also, it can be rearranged to have layers behind and in front of each other. 

Always remember to save.             

                                                                                                

 

 

 

 

 

 

 

 

 

 

 

Tools 

Color 
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Step 6. How to unlock a background layer.  If a layer is locked, then it will have a 

lock symbol. To unlock, all you have to do is double click until the new layer screen 

appears. You can name the file if you like so you will not get confused when you add 

more layers, So by adding more layers all you have to do is right click your mouse 

on a layer and click Duplicate Layer on New Layer. 

 

 

 

 

 

 

 

 

 

 

 

 

Step 7. Layers. In this project, you will need 3 (three) new layers to have your new 

work in a separate layer (Circle, Colors, background, etc.) In the layer’s setting, the 

layers (top to bottom). Also, the layers are movable in order.  

 

 

 

 

 

 

 

 

 

  

 

 

 

https://content.instructables.com/ORIG/FHC/I7QW/HTJP9Z75/FHCI7QWHTJP9Z75.png?auto=webp&frame=1&fit=bounds&md=2b32caa58a347cea555dd73506cf0845
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Step 8. Creating your circle. Click on your first layer to make sure it is selected. Then 

go to the Edit > then click Stroke > edit stroke pixel > change color either to your 

background or foreground. Next in the same layer > go to edit again > stroll down to 

fill > set your color > then click ok. Your shape should look like this circle. Lastly, go 

to select and deselect. 

                             Edit > Stroke 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  

 

 

Change the color 

https://content.instructables.com/ORIG/FIX/OMWS/HTJPA0P2/FIXOMWSHTJPA0P2.png?auto=webp&frame=1&width=1024&fit=bounds&md=1b874d9a0ac88d189e1957f84bc24093
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Step 9. Select your 2nd New Layer. First select a new layer (naming is in option, then 

go to your gradient on in the toolbar and click. Notice that your top bar changes, 

there are options to create a new set of colors or work on the pre-made colors and 

there is an option to set the colors at an angle you prefer. Then create new gradient 

> press save > new gradient added selection. Now ready to adjust your background. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

   Second Click 

Choose Create 

new layer 

 

https://content.instructables.com/ORIG/F1J/B8SJ/HTJPA2J0/F1JB8SJHTJPA2J0.png?auto=webp&frame=1&width=1024&fit=bounds&md=0a81990a47e2b7f95270413d1611bfa1
https://content.instructables.com/ORIG/FZ2/NHH8/HTJPA3F0/FZ2NHH8HTJPA3F0.png?auto=webp&frame=1&fit=bounds&md=9380612a0a6ed511f9d3fc37b3ecd9ea
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Step 10. Making your masterpiece festive. First, take your file and set the background 

gradient to > right click> duplicate layer. Take note, you are duplicating your layer 

because if you stylize on your only gradient background it will be difficult for you to 

remove the styling option. FYI (The more you have the better then you can choose 

the best style that you like. Go to one of your duplicate layers that you completed 

and you can click the eyeball for the layers you are not using. Then go to the top of 

your screen > find Filter > search for Stylize > go through your options. Save your 

work. P.S You can add more than one filter on an existing filter ( Filter > Stylize > 

extrude > box tool > ok >. 

 

 

 

 

 

 

 

 

 

 

 

Click to 

save 

https://content.instructables.com/ORIG/FP5/3LVY/HTJPA3WI/FP53LVYHTJPA3WI.png?auto=webp&frame=1&width=1024&fit=bounds&md=897bfb2760bd627c69b15d3be35e13ff
https://content.instructables.com/ORIG/F2G/TABJ/HTJPA3HC/F2GTABJHTJPA3HC.png?auto=webp&frame=1&fit=bounds&md=916d02d5bc4947205028ede6fffddbf0
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Assessment 

 

True or False: Read the following statements carefully. Write True if the 

statement is correct and write False if the statement is not correct. 

Write your answers on the blank provided before its number. 

__________ 1. Software is a set of instructions data or programs used to 
operate computers and execute a specific task. 

__________ 2. A command is used to make the artwork colorful, and 
attractive. 

__________ 3.  Graphic design software is not important in designing 
graphics-related things. 

__________ 4. Art created from graphic design software is called digital art. 

__________ 5. A menu is an instruction to a computer or device to perform a 
specific task. 

__________ 6. The pen tool is used to create a point or line in every direction. 

__________ 7. Photoshop is a photo editing and raster graphic design software 

that allows users to create, edit, and manipulate various 

graphic as well as digital art. 

__________ 8.  Everything that runs on a computer from an operating system 
to a diagnostic tool, video, game, or app is called digital art.   

__________ 9. GIMP is an excellent open-source photo editing program and a 
user-friendly app for digital art design. 

__________ 10.   You can use different applications like GIMP and Photoshop 
even without installing them. 

 

 
 
 
 

  

Did you get it 

right?  

Good job! 
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Additional Activities 

 

 In your notebook, write a reflection on the things you learned in this lesson 

and their relevance to you. Tell how you can apply what you learned in your daily life 

and give specific examples in which you feel this learning will come easy. 
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Answer Key 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

What I Know 

1.C 
2.A 
3.D 

4.A 
5.D 
6.B 
7.A 
8.A 
9.B 
10.A 

 

Assessment 

1.TRUE 
2.FALSE 
3.FALSE 

4.TRUE 
5.FALSE 
6.TRUE 
7.TRUE 
8.FALSE 
9.TRUE 
10.FALSE 

 

What's More 

1.Based on Rubrics 
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